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Calendar

January, 2008
8 PCR: 7:00 pm.

9 Competition Night: 7:30 pm.
Judge: Elis Rosenberg.
Hospitality: Melissa Clark, Ira Adler
and Beth Wieczorek.

14 Photo Critique: 7:30pm; Mason’s
16 Board Meeting: 7:30 pm; Mason'’s.
17 Craft of Photography 7:30 pm; Mason’s

23  Workshop: 7:30 pm.
Guest: Evelyn Jacob, Photoshop.
Hospitality: Jessica Stansbury McCargo
and John Burgess.

26 Field Trip: Udvar-Hazy.

30 Program: 7:30 pm.
Guest: Henry Ng.
Hospitality: Shereen Kopp,
Donald Martell and David Davidson

February, 2008

5 PCR: 7:00 pm.

6 Board Meeting: Hoffman’s: 7:30 pm.
13 Competition Night: 7:30 pm.
20 Workshop: 7:30 pm.
27 Program: 7:30 pm.
tbd Photo Critique; 7:30 pm, Kent Mason'’s.
tbd Craft of Photography 7:30 pm; Mason'’s
tbd Field Trip; National Building Museum.

Competition Assignment:

Yin/Yang

Two subjects with contrasting
characteristics captured in a sin-
gle image. May be either realistic
or abstract. Altered: The relation-
ship between the two subjects
must be created by making a col-
lage from two shots. (Must have
been taken on or after June 1,
2006).

Happy New Year!
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nbcclensandeye@yahoo.com
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January 23 Workshop
Photoshop Workflow and

Techniques
Evelyn Jacob

On Wednesday, January 23, the
workshop evening will focus on
Photoshop--with demonstrations
and discussion led by several
NBCC members. We think this
Photoshop workshop will have
something for Photoshop experts
through newbies alike.

Two NBCC members (Tatiana
Watson and Don Martell) will
each use one of their images to
share their  workflow  from
capture, through processing raw
images and Photoshop work, to
preparation for printing. Tatiana is
known throughout the club for her
highly creative and artful altered
images. Don, a new member to

Cont'don p.4

NBCC Snow/Inclement
Weather Policy

Our regular meetings and work-
shops will usually be cancelled
if snow or inclement weather has
caused the cancellation of Mont-
gomery County Schools. Howe-
ver, if conditions have improved
considerably before meeting
time, they may be held. If you
are uncertain call one of the

officers of the club listed on page
2 of the orange booklet or on the
back page of the newsletter, or
check the NBCC web site for the
status www.nbccmd.org .

Henry Ng at Program Night

Nancy Garwood

Henry Ng was born in China
and was raised in Hong Kong.
He immigrated to the United
States at the age of 18 in
1968. Henry is an international
well known photographer and
has been involved in photogra-
phy for more than 35 years.
His interest in Photography
started when he was 13 years
old and he particularly likes
photographing people, land-
scapes, human-interest sub-
jects, nature, sports and crea-
tive work. He is actively
participating in the Internatio-
nal Exhibition of Photography
competitions (also known as
an International Salon) from all
over the world and has an
exceptional international com-
petition record. He was ranked
among the top exhibitors in the
world in the Who's Who in
Photography  published by
Photographic Society of Ameri-
ca (PSA) numerous times.
These honors include 5win the
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Member Profile

Text and photo by Jean Hanson

VA

Angelique Raptakis

As far back as her mind can
stretch, Angelique Raptakis re-
members being intrigued by pho-
tography and the possibilities
offered by the photo image. As a
child, she perused the albums of
her grandparents which gave her
a sense of her family and of their
life in Greece before they settled
in America.

Her father was an avid slide pho-
tographer and documented tra-
vels and family life. He met and
married Angelique's mother in
Greece where he was stationed
with the U.S. Air Force. After re-
turning to America, the couple
had three children, two girls and a
boy, of which Angelique is the
youngest. They still reside in Sil-
ver Spring and celebrate every
holiday with their children. About
two years ago, Angelique pur-
chased a house of her own, in the
same neighborhood in which she
was raised.

Angelique attended Good Coun-
sel High School and, upon gradu-
ation, matriculated at the Univer-
sity of West Virginia in Morgan-
town. She liked the geography of
the state and of the Morgantown
area, a strong motivation in her
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choice of colleges. She received
her BA in Psychology in 1999.

After graduation, she began
working two jobs. During the day,
she was a logistics coordinator
for a government contractor, Ca-
pital Consulting Corporation. In
the evenings, she worked for the
Montgomery County Department
of Corrections, Pre Release Ser-
vices, assisting case workers.
After an arduous year, Capital
Consulting "won out" by offering
Angelique a job as an event
planner and also the title of
"official photographer." Since their
clients often needed portraits of
their executives or group photo-
graphs of event attendees, Ange-
lique's skills are in demand.
Occasionally she even sells ima-
ges for reproduction in news-
letters or on websites.

For this work, she uses a digital
camera, a Canon 30 D, recently
upgrading to a Canon 1D Mark Il
N. She uses on-camera flash, a
Speedlite 580 EX. She owns both
Gitzo and Manfrotto tripods with
Kirk Bh-C and Arcatech GV2 ball
heads, but doesnt use this
equipment as often as she
should. She is trying to become
more disciplined with it. Mostly
she relies on natural light with the
occasional help from the Speed-
lite to allow a quick enough shut-
ter speed to hand-hold her cam-
era.

In her spare time, Angelique has
always found plenty of subjects to
photograph. In 1993, she pur-
chased a Nikon point-and-shoot
to go into her backpack. A friend,
her older sister, and Angelique
made a trip to Europe, traveling
from England, through Holland,
France, Germany, Austria, and
Italy to finally end up with family
in Greece. Although they spoke
only English, Greek and a little
French, they managed to make
their way about, riding Euro ralil

and saying in hostels. Angelique
documented their journey with
her Nikon.

In 2000, she purchased her first
"real" camera, a Canon Rebel
2000. With this, she began to do
"street photography" in D.C., and
captured the sights on a vacation
trip to NYC. She also did some
event photography for friends and
relatives.

Now, one of her main interests is
macro photography, particularly
portraits of insects. She likes to
get very close to them so she can
capture their features, colors and
textures. For this, she uses a MP-
E 65mm 1-5X magnification lens
with complete manual focus. She
says it takes a lot of patience to
get a good image of a bug.

Angelique processes her images
with Adobe Camera Raw and in
Photoshop CS3. She used to
have them printed on MPix.com,
but has recently purchased an
Epson 3800 to do her own
printing. At present, she favors
Epson Photo Lustre paper but is
eager to experiment with other

paper types.

While researching area camera
clubs, Angeliqgue discovered the
NBCC on the Internet. At that
time, the membership was full. A
year later, her friend and Club
member, Rakesh Malik, encoura-
ged her to attend meetings. She
was present at several events
last year and became a full mem-
ber in 2007. She enjoys seeing
other peoples' work and learning
how differing points of view can
effect the images. She also likes
the feedback from judges on her
images during competition night.

While waiting to join NBCC,
Angelique also joined the Silver
Spring Camera Club. She is now
secretary of this group. Since
their members compete only in
slides and prints, she is encoura-
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ging them to try electronic com-
petition and has received assis-
tance from Tom Field on this
project.

Angelique competes in both
Novice Color Prints and Novice
Electronic. Her image, Backward
Glance taken at a Renaissance
Festival, won first place in No-
vember, and was also accepted
for the Sandy Spring exhibit in
January. A couple more of her
images won awards at the De-
cember Competition night.

As to her aspirations for a full-
time career in photography, An-
gelique feels that she has the
passion and the interest, she just
needs more skills. Towards this
goal, she is planning to attend a
seminar with Rod Planck in
Michigan next summer, and a
workshop with Tony Sweet in the
fall.

Angelique has sold many of the
images she has taken at bap-
tisms and weddings. She has a
commission coming up soon to
do a friend's wedding. She also

sells images taken as part of her
day job. Occasionally she sells an
image she has taken "just to suit
herself' and that, she says, is the
most satisfying sale of all.

Angelique tries to see the beauty
in her environment, particularly
the commonplace that is easily
overlooked, from the colors of the
setting sun to the intricate pat-
terns in the eye of a butterfly, to
the grace of a withering floral
bloom. She believes that beauty
is everywhere and we can see it
once we fully open our eyes.

SRS - - ] plalelinlly ' olaikilis imiubely 0 olelhilklh
Evaluating the Experimental Year
Chuck Lee

Last spring the Board voted to use the 2007-2008
Program Year to experiment with consolidating what
had been the practice since the Club’s inception of
holding two consecutive competition nights — the
first and second Wednesdays of each month — into
one Competition Night per month to be held on the
first Wednesday. The second Wednesday then
would be used as a Workshop Night devoted to
experimenting with different topics and different
formats. Feedback forms would be used to help fine
tune the events during the year.

The recommendation for the Experimental Year
came from a Special Study Committee headed by
Evelyn Jacob and composed of Melissa Clark, Joel
Hoffman, Kent Mason, Bob Peavy, Tom Sullivan,
and Judy Switt. The committee was charged with
evaluating how the Club was fulfilling its constitutio-
nal purpose and objectives — providing opportunities
for learning and exchanging ideas about photogra-
phy, providing programs and competitions, and
offering constructive critiques and suggestions. A
survey indicated that 60 percent of the membership
supported one competition night per month and
provided a wealth of information regarding member-
ship interests.

To evaluate the success of this year's changes in
better meeting the constitutional objectives of the
Club, the Board at its December meeting approved
an ambitious evaluation schedule designed to
provide it with the views of an informed membership
and other data.

To organize the evaluation process and gather
information needed by the Board on issues it would
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like to examine, the Special Study Committee was

re-activated. A survey of the membership is planned
for distribution on March 20, to be turned in by April
11. In the meantime, articles in both the February
and March newsletter editions will highlight a
number of issues to be considered in the survey
from various perspectives. The Board, at its regular
February, March, and April meetings will discuss
and refine the evaluation process, and then hold a
special one-issue meeting on April 30 to make a
final decision on the structure of Club programming
for Program Year 2008-20009.

In making the final determination, the Board needs
to know what the membership thinks regarding not
only the changes made this year -- the consolidation
of competitions into one night, the Workshop Night
experiment, consolidation of Altered Images into
only the projection format, time management
considerations, etc. — but any others ideas that need
to be addressed to improve provided Club services.
Members are encouraged to make their views
known to the Special Study Committee members
over the next few months.

General Motors was once the envy of the auto-
motive world. At times there was even a waiting list
to get a Chevy. Unfortunately for GM, its Board did
not see the need to change to meet the expecta-
tions of the next generation. Taking a different
approach, the NBCC Board hopes to keep its ear to
the ground and its finger on the membership pulse.




Ellis Rosenberg To Be January Judge
Ira Adler

This is Ellis Rosenberg’s first appearance at the
North Bethesda Camera Club. An amateur photo-
grapher for over 40 years, he is currently Chair of
the Reston Photographic Society and is a board
member of The League of Reston Artists that
includes the RPS. He also currently serves on the
board of The Meadowlark Photo Expo. Ellis has
been designated as "The Official Photographer” on
a number of occasions for diverse groups of people
and organizations. He is a recent graduate of The
Joe Miller Seminar on Judging, and is eager to put
the knowledge gained from the seminar together
with his experience as a competition judge. (NBCC's
Judy Switt and Roy Sewell are also graduates of the
seminar.) Ellis' most recent judging assignments
have been with the Gaithersburg Camera Club, the
Loudon Photo Club, and the Vienna Photographic
Society.

Ellis offers the following criteria that he uses as a
camera club judge: “My first consideration would be
conformity with the rules of the competition. Next
would be the three C’s — craftsmanship, composition
and creativity. The judging should be a learning
experience for everyone involved, including the
judge. Negative aspects should be minimized while
focusing on the positive attributes of the work.
Originality, uniqueness, feeling, mood and capturing
the moment would hold a prominent place in the
selection criteria.”

He can be reached at erosenberg@cox.net and at
703-968-7318.
AT, ST, AR LOTTES Wi AR BETes,

January Workshop (cont’d from p.1)

the club, teaches Photoshop for the Washington
School of Photography.

There also will be “how to” demonstrations of some
Photoshop techniques. Tatiana and Don will each
demonstrate one technique used in their workflow.
In addition, Anita Van Rooy will show how she
creates her “signature” flower images on a new
background and Carol Lee will share the technique
to add “glow” to an image, which she learned at a
recent Andre Gallant seminar.

Come and see what some of our talented

Photoshop users have to share.
‘mY . ._.-/_“1r’_“-‘_:4.’q—“‘-‘_“ -~ 7& o~ TV
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Henry Ng (cont’d from p.1)

world in color slides (2004), 1st in the world in
Color Slides (2005) and 3rd in the world (1st in
North America) in Color Slides (2006). He has
received numerous salon acceptances and
Gold, Silver and Bronze medals/trophies in
these contests. Recently, his image Fishing
Light was selected by PSA from thousands of
images as the image for the PSA’s 2008 handy
promotion card. Henry has also received
photographic honors from many prestigious
photographic societies throughout the world
including the Photographic Society of New
York, Hong Kong Camera Club, Houston

Chinese Photographic Society and others.
EESEEEEReEEeeeaEaEeasE
Adjustments to the 2007-8 Orange Booklet

New e-mail for Willem Bier: wbier@verizon.net.

: QD
Hint Found on the Internet

When working with a layer (background layer or a
subsequent copy) that has a selection made, "Ctrl-J"
duplicates only the selection but "drag-to-duplicate
layer-icon" duplicates the entire layer with the selection
showing. | use one or the other of those two methods
depending on what I'm trying to accomplish.

This is very true. If you have a selection active when
you create a new layer from copy (either by choosing
Layer > New Layer Via Copy from the menu or by
holding Ctrl/Command while pressing J on the
keyboard) the new layer will consist of only the
selected pixels. While this is helpful in the sense that
you can duplicate only the pixels you need (thus
helping to reduce the growth in file size), | actually
prefer to avoid this process, duplicating the entire layer
instead. While this does increase the file size
significantly, it also maximizes your flexibility in terms
of layer masking.

If you're particularly concerned about file size, you can
still use the select and duplicate method to minimize
the growth in file size. However, in that case | strongly
recommend that you create a very rough selection that
includes more of the area than you think you'll need.
Then, after duplicating just those pixels add a layer
mask to fine-tune the result so you can only see the
pixels you really want. This way, if you find out you
made a mistake with your original selection or mask,
you can always adjust the layer mask instead of
having to start over.
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December, 2007, Splinters from the Board
Chuck Lee, President

The following were appointed to serve on the Com-
petition Assignment Committee: Roy Sewall (chair),
Cynthia Keith, Chris Hanessian, Nikhil Bahl, and
Jean Yuan. They will develop the competition
assignment topics for Program Year 2009-2010 and
report their recommendations to the Board in March.

The following were appointed to serve on the
Nominating Committee: Janet Myder Hammack
(chair), Nancy Garwood, and Bill Richards. Their
slate of officers will be published in the May news-
letter. A vote by the membership will be held on
Workshop Night, May 14, 2008.

As a result of publishing the new Lending Library
policy last month, a number of delinquent loaned
tapes and DVDs were returned. A list of the current
library inventory is posted on the Club Web site.

Approval was given to a schedule for evaluating the
current Experimental Year. Highlights of that sche-
dule are noted in a president’s article on page 3.

Board recommended that the jurying process for
future Club events be published beforehand so that
members would better understand how selections
are made.

Board sanction was given to member participation in
the March Inter-Club Competition hosted by the
Bowie/Crofton Camera Club.

President was given authority to create the special
committee position of Inter-Club Coordinator to act
as a liaison with other camera clubs and organiza-
tions interested in photography. Any member inte-
rested in providing Club service in such a position
should contact the president.

As a good-will gesture, approval was given for the
president to offer the church in whose fellowship hall
the Club meets, an opportunity to have its
leadership photographed.

There are now 14 on the membership waiting list.
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PSA

Photographic
Society of
America

RSAINEWS

Judy Burr, PSA Representative

Since | am on the road, | didn’t prepare an article for
the newsletter. However, | am happy to announce
that our newsletter, The Lens and Eye received a
PSA Director's Creative Award for Out-standing
Features award for Motivational Focus. Congratu-
lations and thanks to our excellent editor, Tom
Sullivan. NBCC has been recognized several times
over the years for our excellent newsletter. Silver
Spring Camera Club received a Second Place
award for small clubs while the Delaware Photo-
graphic Society won First Place and Bowie-Crofton
won Third Place for large clubs. Vienna Photogra-
phic Society also received a Director's award for
Use of Photography. It is interesting and worthwhile
looking at other clubs’ newsletters. There are links
on our website for some and others can be found by
going through the PSA website.

.

NI?;-CC Member Doing a Photoshop Class

Don Martell will be teaching Photoshop for Photo-
graphers at the Washington School of Photography
starting on January 17, 2008. This a beginner work-
shop and assumes a minimum familiarity with
Photoshop CS3. If interested, contact the WSP at:
4850 Rugby Avenue, Bethesda, MD 20814, (301)
654-1998, web site at: http://wsp-photo.com/ The
workshop is listed under “Workshops” and under
that “Digital Specialties.” Price: $350.00

Hint: Action-stopping Rules

To stop action moving across the frame that's per-
pendicular to the lens axis, you need shutter speeds
two stops faster than action moving toward or away
from you. For action moving at a 45-degree angle to
the lens axis, you can use a shutter speed one stop
slower. For example: If a person running toward you
at moderate speed can be stopped at 1/125 sec,
you'll need a shutter speed of 1/500 sec to stop the
subject moving across the frame, and a shutter
speed of 1/250 sec to stop him if moving obliquely
with respect to the camera.



http://wsp-photo.com/

January Field Trip — Udvar-Hazy Center

January 26, 2007, 8:00 AM

Poto by Carolyn Russo/NASM

The NBCC January Field trip is to the Steven F.
Udvar-Hazy Air and Space Annex near Washington
Dulles International Airport. This is the companion faci-
lity to the Air and Space Museum on the National Mall.
The building opened in December, 2003, and provides
enough space for the Smithsonian to display the thou-
sands of aviation and space artifacts that cannot be
exhibited on the National Mall. The two sites together
showcase the largest collection of aviation and space
artifacts in the world.

Photo by Dane Penland/National Air and Space Museum

A newer section of the Center is the James S.
McDonnell Space Hangar. The centerpiece of the
space hangar is the Space Shuttle Enterprise. Other
space artifacts include the Gemini VIl space capsule;
the Mobile Quarantine Unit used upon the return of the
Apollo 11 crew; and a Redstone rocket.

By special arrangements, NBCC participants will be
allowed into the facility 2 hours prior to the facility
being opened to the public. We will be the only
individuals in the facility during this time period.
Tripods will be permitted but only during this 2-hour
time period. After 10:00 AM when the public is
admitted, tripods will have to be put away, but
monopods will be permitted. Flash lighting is permitted
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throughout the day. Our escort during this special
advanced opening will be Scott Willey. Scott is a full-
time docent at the Center, and is a highly acclaimed
photographer in his own right. Scott has an intimate
knowledge of the Center and all of the artifacts
contained there. He will be eager to share information,
offer photographic suggestions and answer any ques-
tions that may come up.

Directions to the Udvar Hazy Center: From Bethesda:
[-495 West (Capital Beltway) to the Dulles Toll Road
West (Route 267). Exit the toll road at Route 28 South
(Exit 9A) and travel south 3.5 miles. Exit at Air and
Space Museum Parkway and follow the signs to the
Steven F. Udvar-Hazy Center.

Dulles Int'| Airport

@5

Steven F.

Udvar-Hazy
Center

Air and Space Museum Parkway
M sully Plantation

@ Chantilly

Enter the parking lot at Gate 5, which is the gate
furthest to the right. The guard will have a list of the
names of participants so he knows the folks are really
part of the group. Right after the gate, take the first left
and a quick right to get into the parking lot (if you go
straight, you will come up in front of the building and
will have to drive all around the parking lot in order to
get down into the lot.)

Note: Send an email to David Davidson at
david@davids-photos.com if you plan to participate.
Individuals who have been identified as participants
and are on the advanced list of participants will get
free parking, others will have to pay the daily parking
rate which is $12.00.

Luncheon Arrangements: At 12 Noon, we will recon-
vene at Famous Dave’s Legendary Pit Bar-B-Que.
Famous Dave'’s is located at 14452 Chantilly Crossing
Lane, Chantilly, VA 20151, less than 1 mile from the
Udvar Hazy Center.

Photo by Nancy Garwood
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NBCC Lending Library Inventory

Current as of December 18, 2007

Submitted by Carl Root

No. Title Sponsor Medium
1 Photo Retouching Photoshop Tape
2 Creating Great Grayscale Images Photoshop Tape
3 Color Correction Made Easy Photoshop Tape
4 Layers Techniques Photoshop Tape
6 Selections Photoshop Tape
7 Night Photography Photoshop Tape
8 Photoshop for Beginners Photoshop Tape
9 Masters of Wildlife, Frans Lanting Nikon School Tape
11 | Masters of Photojournalism Nikon School Tape
12 | Master of Portraiture Nikon School Tape
13 | Masters of Action Nikon School Tape
14 | Essence of Light Nikon School Tape
15 | The Photographers National Geographic Tape
17 | Field Techniques and Professional Tips John Shaw Tape
18 | Effective Composition (Part 1) John Shaw Tape
20 | Identifying, Organizing and Marketing your work John Shaw Tape
23 | Successful Close-ups John Shaw Tape
24 | On Location with Art Wolfe Tape
25 | Creative Outdoor Photography; Part 1 Galen Rowell Tape
26 | Creative Outdoor Photography; Part 2 Galen Rowell Tape
28 | Wacom Graphics Tablet Photoshop Tape
29 | Mountain Memories Jim Clark Tape
30 | Lighting Basics Dean Collins Tape
32 | Creating Digital Art Photoshop CD
33 | Working with Adjustment Layers Photoshop DVD
34 | Masters of Travel Nikon Tape
35 | Photographic Workshop Vincent Versace DVD
36 | Photoshop Field Guide John Shaw CD

The following items are missing from our library and are currently unavailable:

5 Selection Secrets Photoshop Tape
10 | Masters of Action, Various photographers Nikon School Tape
16 | Understanding Exposure John Shaw Tape
19 | Effective Composition (Part 2) John Shaw Tape
21 | Nature Photography John Shaw Tape
22 | Advanced Close-ups John Shaw Tape
27 | Secrets of Photoshop Maters DVD
31 | Advanced Masking Techniques Photoshop DVD

Note: There are new Rules and Procedures for borrowing material from our media library. Please see the December
Lens and Eye, Page 4, and the NBCC web site, http://www.nbccmd.org/library.htm , for the details of these rules.

HA\R BY}
NEWEVERE
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“Body of Work” Critigue Night a Success members who attended seemed to really enjoy the

. . d the images presented. An example of
On the December “12™ Workshop night a “Body of venue an : o I
b s . one of the Bodies of Work is given by Sigrid
Work” critique was held where merﬂnbers b”rought in Vollerthun's collection below:
a group of 5 — 8 images that were “related” and
represented a collective “body of work”. The

Image 2

Image 5

These critique nights are very valuable opportunities for members to see other member's works, hear
constructive feedback on these images and their own images. Please plan to attend the next critique
workshop meeting. Watch the NBCC schedule in the Lens and Eye or on the web site for the date (s).
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Sandy Spring Museum Exhibit Update

Alan Sislen, Melissa Clark, Exhibits Committee

On Wednesday, January 9", forty-six NBCC photo-
graphers will have their images featured in an exhi-
bition opening that day at the Sandy Spring Muse-
um entitled Photographic Visions: Images from the
North Bethesda Camera Club.

The Museum is located at 17901Bentley Road,
Sandy Spring in Montgomery County, MD. Framed
prints, ready for hanging, must be delivered to the
Museum between 9 and 10 a.m. on Monday,
January 7", two days before the exhibit opens. The
exhibit, which includes approximately sixty photo-
gratphs in all, will remain up until Monday, March
31°%.

An artists’ reception will be held at the Museum on
Sunday, January 13", from 2 — 4 p.m. All Club
members are invited to attend. The Museum will
publicize the exhibit to its membership and through
the Olney Gazette. All sales will be handled through
the Museum, which will receive a 30% commission
on any works sold.

Participating Club members will receive additional
details via e-mail. We hope anyone interested in
seeing these images will come to the reception on
the 13", or drop by during Museum hours, which are
9 am to 4 pm on Mondays, Wednesdays and Thurs-
days, and noon to 4 p.m. on Saturdays and Sun-
days.

e 23
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Tim Grey

Reprinted with permission from Tim Grey

| discovered that by making the canvas size bigger
the black border shows up on the edge of the
canvas. This solves a printing problem | was having,
but | don't understand where this border is coming
from.

When you enlarge the canvas (Image > Canvas
Size) for an image that has a Background image
layer, the new area created around the image itself
will be filled with the background color (defined by
the color picker on the Tools palette). By default that
means the new space will be white, which for a
printed image means it will be "invisible". Of course,
if you change the background color to something
else, it means you'll have a border around your
image (and this is how the Canvas Size option is
used to create a matted image look by applying it
multiple times with different colors).
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If there isn't a Background image layer (for example,
if you have double-clicked the layer and clicked OK
to convert the layer to a "normal” layer) the new
area added to the image will be transparent,
regardless of the current background color.

— E— — ——
Pat Bress Exhibit

Provided by Chuck Bress

Long time NBCC member Pat Bress will be having a
show of her images at Leisure World, Clubhouse 2,
through March 4, 2008. A reception will be held on
January 4, 2008, from 1-3 PM in Clubhouse 2. Pat'’s
artist’s statement follows:

The Lens is Like an Eye Focusing on Emotions

The true lens of the camera is in the mind and heart
of the photographer. This is the lens that lets us all
appreciate the beauty of the world around us. The
lens that looks at a sunset, a flower, a dramatic
landscape or a smile of a child and really gets
“turned on” is not the lens in front of the camera.
Rather, it's the lens inside the photographer.

We all know about grammar in the English
language. We know where to place the commas and
the periods. What is important is to do as the writer
does. He is not as concerned about where the
comma goes as he is about the words flowing from
his heart. The writer makes grammar the secondary
thing, just as the photographer makes the mech-
anics a secondary thing and concentrates on the
importance of what he’s feeling and trying to “say”
with his photographs.

Photographs speak in a strong language. They can
bring out a person’s raw emotions and can make
someone happy, sad and even angry. Photographs
can stir people to action or just make us feel good.
They can make visible what others can only sense.
Remember it's not the brush of the artist that
produces the painting, not the bow of the violin that
produces the music nor the pen of the poet that
writes the sonnets nor the camera which produces
the photograph.

Sunset Rule

To get a properly exposed sunset, meter the area
directly above the sun (without including the sun). If
you want the scene to look like it's a half-hour later,
stop down by one f-stop, or set exposure compen-
sation to minus one.



Electronic Competition 12t Place Winners

December 2007

Novice — Angelique Raptakis — Water and Rock

Altered — Lucia Goldman — Warm and Cozy

January, 2008

Nature's Best Camera Club Contest

NBCC is planning to enter the “Camera Club”
category of Nature’s Best Windland Smith Rice
International Competition for 2008. Kent Mason is
heading up the activity, currently assisted by Tom
Sullivan. We are looking for contributions from mem-
bers in the following categories as specified by
Nature’s Best: Animal Antics, Art In Nature, Birds,
Creative Digital, Endangered Species, Environment-
al Issues, Landscape, Oceans, People In Nature,
Plant Life, Small World Spectaculars, Weather,
Wildlife and Zoos & Aquariums.

This is a very prestigious contest with very stiff
competition from all over the world. NBCC will be
looking for it's BEST outstanding images possible.
We are asking mem-bers who might have images in
these categories that they feel are truly exceptional
to consider providing them for entering into this
contest. We will be looking for a balance in the
above mentioned categories, so please look over
the categories carefully when considering your entry
(ies). Please send your images via e-mail to Tom
Sullivan at sullyinmd@comcast.net in the same
format you would send for a competition. Or bring
them on a CD or USB drive to any meeting in
January and give them to Kent or Tom. The
deadline for the first submission is the Program
meeting, January 30, 2008 We will use these for the
selection process. We can submit 20 final images.

For the final submission, we will need the original
RAW or Hi res Jpeg files in the early March
timeframe. For more information about the contest,
see their web site:

http://www.naturesbestphotography.com/pages/cate

gories.html
So, go look at your library of images and find some

of those great images that we know are out there in
NBCC land.
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Sunrise/Moonset and Sunset/Moonrise times for Full Moons of 2008.

For those of you who would like to try to “shoot the full moon” sometime in 2008, here is a listing of the full (and almost
full) moons for the year. A red number in the "Diff” column means when the sun sets (rises), the moon is not up.

Date Sunrise | Moonset | Diff Sunset | Moonrise | Diff | Azimuth
Times are EST A.M. A.M. Min. P.M. P.M. Min. Set/Rise

Jan 21 7:23 6:52 -31 5:16 4:18 -58

Jan 22 7:22 7:35(Full) 13 5:17 5:33 16 298/64

Jan 23 7:22 8:10 48 5:19 6:45 1:26

Feb 19 6:55 6:08 -47 5:50 4:25 -1:25

Feb 20 6:54 6:38 -16 5:51 5:35(Full) -16 288/75

Feb 21 6:52 7:04 16 5:51 6:41 50

Feb 22 6:51 7:27 36 5:53 7:45 1:53
DalightSavTim

Mar 20 7:11 6:30 -41 7:21 6:31 -50

Mar 21 7:09 6:52 -17 7:22 7:34(Full) 12 268/96

Mar 22 7:08 7:14 6 7:23 8:46 1:23

Mar 23 7:06 7:37 31 7:23 9:37 2:14

Apr 18 6:27 5:19 -1:08 7:49 6:26 -1:23

Apr 19 6:25 5:42 -43 7:50 7:27 -23

Apr 20 6:24 6:06(Full) -18 7:50 8:29 39 249/115

Apr 21 6:23 6:34 11 7:51 9:31 1:40

Apr 22 6:21 7:06 45 7:52 10:32 2:40

May 18 5:53 4:37 -76 8:17 7:23 -54

May 19 5:52 5.07 -45 8:18 8:24(Full) 6 240/123

May 20 5:51 6:06 15 8:19 9:23 1:04

Jun 17 5:42 4:24 -1:18 8:36 8:13 -23

Jun 18 5:43 5:12 -31 8:36 9:03(Full) 27 233/126

Jun 19 5:43 6:07 24 8:37 9:47 1:10

Jun 20 5:43 7:06 1:23 8:37 10:25 1:48

Jul 16 5:56 3:59 -1:57 8:32 7.46 -46

Jul 17 5:57 4:58 -59 8:31 8:25 -6

Jul 18 5:58 6:01(Full) 3 8:31 8:59 28 240/117

Jul 19 5:59 7:05 1:06 8:30 9:28 58

Aug 15 6:22 4:53 -1:29 8:02 7:30 -32

Aug 16 6:23 5:59 -24 8:01 7:58(Full) -3 249/106

Aug 17 6:24 7:04 40 8:00 8:22 22

Aug 18 6:25 8:10 1:35 7:58 8:46 48

Sep 13 6:48 4:49 -1:59 7:19 6:24 -55

Sep 14 6:49 5:55 -54 7:17 6:49 -28

Sep 15 6:50 7:02(Full) 12 7:16 7:14 -2 270/86

Sep 16 6:51 8:11 1:20 7:14 7:40 26

Oct 13 7:16 5:51 -1:25 6:32 5:40 -52

Oct 14 7:17 7:02 -15 6:30 6:08(Full) -22 283/73

Oct 15 7:18 8:16 58 6:29 6:41 12

Oct 16 7:19 9:33 2:14 6:28 7:22 54
DST Ends; Times = EST |

Nov 12 648 6:06 -42 456 4:13 -43

Nov 13 649 7:24(Full) 35 456 4:59 3 301/58

Nov 14 650 8:41 1:51 455 5:56 1:01

Dec 11 7:17 6:11 -1:06 4:46 3:35 -1:11

Dec 12 7:18 7:25(Full) 7 4:46 4:39 -7 305/55

Dec 13 7:18 8:30 1:12 4:47 5:52 1:05

http://aa.usno.navy.mil/data/docs/AltAz.php ; Azimuth, Altitude data. given in true degrees, not magnetic
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Results of Competition for December 2007 — Serenity

Competition Judge: Josh Taylor

Prints
Black and White - 11 entries

1% Chris Henessian
2" Alan Sislen

3% Judy Switt

HM  John Villforth

Lucy

David and Leonard
Jenne Farm, Infrared
Circle of Stone

Color, Novice — 3 entries

1% Marcia Loeb

Emerging Lotus
Color, Advanced - 27 entries

1% Nikhil Bahl

2" Bob Dargel

3 Anita van Rooy
HM  Nikhil Bahl

HM  Cynthia Keith
HM  Cynthia Keith
HM  Bob Peavy

Wiy

Fire Dept Wants Something

Serene Reed
Remembering
Inside Clematis
Swans in Fog
Come Aside

Be Still and Know
Evening Stroll

wbV

Barbara DeLouise found this sign whilst traveling
the southwest Virginia countryside. | hope they fight
fires better than they make signs!

Submitted by Barbara DelLouise

Quick Flash-fill Rule

When using an automatic flash unit that doesn't
provide auto flash-fill ratios, set the flash's ISO dial
to twice the ISO you're using. Meter the scene,
select an f-stop, set the autoflash aperture to the
same f-stop, and shoot. The resulting 2:1 flash-fill
ratio will produce filled shadows one stop darker
than the main subject.

January, 2008

Electronic

Novice — 10 entries

1*  Angelique Raptakis Water and Rock

2 Angelique Raptakis Orange Cloud

3%  Steve Gelband Gas Works
Advanced - 45 entries

1 José Cartas Baby

2" Nikhil Bahl Calm Water

3" Janet Myder Hammack Nap Time

HM  Nikhil Bahl Trees in Fog

HM  Gordie Corbin Rest in Peace

HM  Bruce Davis Sunrise DSC_5115

HM  Dennis Green Mr. Chang

HM  Evelyn Jacob Bleeding Hearts

HM  Judy Switt Woodbury Vermont

HM  Rebecca Tidman Canadian Waters

Altered - 30 entries

1% Lucia Goldman
Tatiana Watson
39 Alex Guo

HM  Gordie Corbin
HM  Gordie Corbin

Warm and Cozy
Sea-renity
Columbine 3

Early Morning Stroll
End of the Day

HM  Gigi Halloran Bridge
HM  Jim Hawkins Solitude
HM  Carl Root Red Shirt
HM  Anita van Rooy Choalla 2
HM  Sigrid Vollerthun Floating

i

Did You Know?
Anita van Rooy

Making the tone of one photo match another

Open the photo you want to repair or match. Find
the photo you want it to match. Go back to the
photo you want to repair or match and under the
menu under Adjustments choose Match Color. At
the bottom of the dialogue box choose the Source
Photo that you want to match. As long as the
preview button is turned on you will see the effect
instantly. You can then use the Luminance slider to
adjust the overall brightness or decrease the
saturation. Very slick!!

If you have the new CS3 and use the wonderful
Quick Selection tool try this: After selecting a small
area of the subject you want to select hold Alt
(Option) and trace around this subject not touching
the part you want to select. This tells Photoshop
what you do not want selected and then the further
selection is going to be much quicker and more
accurate.

-12-



Cumulative Scores for 2007-2008; Thru December, 2007

Black and White Prints Color Prints
Advanced Novice
48  Judy Switt 26 Louise Roy
40 Alan Sislen 20 Marcia Loeb
24  Chris Hanessian 17 John Grupenhoff
12 Carl Root 10 Dennis Green
10 Chuck Lee 10 Angeligue Raptakis
8 Bob Peavy 6 Nancy Garwood

8 Chuck Bress
6 John Villforth Advanced
27 Cynthia Keith
26  Nikhil Bahl

23 Anita van Rooy
20 Bill Richards
17  Luis Bustillos

16 Les Trachtman

-y 15 Bob Dargel
[ 12  Chris Henessian
Hapgy 12 Dan McDermott

dew'r earl 12

Bob Peavy

Chuck Bress

Ed Kawczynski

6 Barbara DelLouise
6 John Villforth

6 Carl Root

B

Tim Grey Comment on Print Preview
Reprinted with permission from Tim Grey

You have spent two days now discussing workflow
related to cropping and resizing. However, perhaps
because it is "obvious," you have not mentioned any of
the details related to resizing. In particular, are you a
believer in the "rule" to resize in increments not
exceeding 10% ? Also, what is your opinion of third
party resizing tools such as Genuine Fractals ?

| didn't go into great detail about the resizing process
because it is indeed relatively straightforward. The
short explanation is to go to Image > Image Size in
Photoshop. Make sure all three checkboxes at the
bottom left of the dialog box are selected, and then
enter values for Width, Height, and Resolution (use
360 for printing if you're not sure of what value to use),
and click OK.

As you can tell from this explanation, I'm not a big
believer in the "rule” to resize in 10% increments (often
referred to as stairstep interpolation). | could easily

January, 2008
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Advanced Electronic Novice Electronic

30 Gordie Corbin 35 Angelique Raptakis
26 Judy Switt 25 Jean Yuan
26 Rebecca Tidman 24 Ira Adler
24 Nikhil Bahl 17 Steve Gelband
24 Kent Mason 14 Nancy Garwood
19 David Davidson 14 Paul Taylor
18 José Cartas 12 Gigi Halloran
16 Alex Guo 9 Jess Stansbury-McCargo
12 Mark Segal 6 Martha Cain-Grady
10 Roy Sewall 6 Dennis Green
9 Bill Wyckoff 6 Dawn Sikkema
ﬁ ‘é?[,f; '\é};?,g Hammack Altered Electronic
6 Dennis Green 42 Tatiana Watson
6 BillHo 36 Gordie Corbin
6 Joel Hoffman 25 Jim Hammack
6 Carol Lee 19 Lucia Goldman
6 Dan McDermott 18 Ira Adler
6 Carl Root 18 Dan McDermott
6 Sigrid Vollerthun 16 Kent Mason
6 Evelyn Jacob 14 Evelyn Jacob
8 Alex Guo
Ed Kawczynski
Nikhil Bahl
s By e Willem Bier
Gﬂ%nr Martha Cain Grady
L™ JOB ‘ Gigi Halloran
Jim Hawkins

Shereen Kopp

Janet Myder-Hammack
Carl Root

Anita van Rooy

Sigrid Vollerthun

SR 5 1T dEy ot T
argue elther position, either for or against, and be (I
think) equally convincing). The bottom line is that one-
step interpolation is actually quite effective. The only
time I've seen a real appreciable difference using
stairstep interpolation was when Unsharp Mask was
applied partway through the process, and even then
the difference was really quite minor especially when
compared to the one-step interpolation with
appropriate sharpening applied after the fact.

As for third-party tools like Genuine Fractals
(www.ononesoftware.com), | find them to be very
good, but generally unnecessary. The major benefit (in
my mind) to Genuine Fractals is that it provides a
much more user-friendly experience for resizing your
images, asking you "real" questions about the image
and output rather than asking you to enter a bunch of
numbers. However, | don't find the results to be
significantly better than the Bicubic interpolation in
Photoshop (better, but not significantly, and | don't
think most viewers could really see a difference in the
final print).

OO OO

- 13-


http://www.ononesoftware.com/

2007 — 2008 NBCC Board of Directors, Standing, and Special Committees

President Vice President Treasurer Secretary Directors
Chuck Lee Tom Sullivan Bob Dargel Jean Hanson Joel Hoffman

Ross Emerson

Voting Members in Bold .
oting Members in Bo Jim Hammack

Program & Judges Workshop Competition Hospitality Field Trips
Nancy Garwood Bob Peavy Judy Switt Gene Haddon David Davidson
Jim Hawkins Kent Mason Tom Field Alan Sislen Louise Roy Jim Auerbach
Ira Adler Carl Root Don Martell Nikhil Bahl Jean Yuan Frank Herzog
Caroline Helou Evelyn Jacob Carol Lee Bill Ho Jim/Virginia Render Ed Kawczynski
Cynthia Keith Jerry Weiss Bill Richards Mike Fleming John Barnes
Ken Briefel Exhibits Church Liaison Bulletin Editor Education & Training
Membership Alan Sislen Janet Myder Hammack Tom Sullivan Kent Mason
Gordie Corbin Melissa Clark
Judy Switt Webmaster
Tom Sullivan
Gallery PSA Representative Club Equipment Competition Image Review
Carl Root Judy Burr Tom Field  Judy Switt Judy Switt Carol Lee
Photo Essa Community Outreach Jim Hammack Anita van Rooy  Tom Field
Stu Mathison Joel Hoffman Technical Advisor Awards Event Coordinator
Librarian Tom Field Catherine Honigsberg
Carl Root
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